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Практическая работа №1
Ознакомление с автоматизированными системами проектирования печатных плат.

1. Цель и задачи работы 
Ознакомление с системой проектирования печатных плат PCAD для MS DOS и приобретение навыков проектирования электронных блоков с использованием данной системы.

Задачами работы являются разработка принципиальной схемы, выданной преподавателем и формирование печатной платы. 

2. Описание системы проектирования PCAD для MS DOS
Система проектирования радиоэлектронной аппаратуры  (РЭА) P-CAD      является интегрированным набором специализированных  программных пакетов и имеет иерархическую модульную структуру. P-CAD  ориентирован на эффективное проектирование принципиальных схем (ПС), полузаказных ИС, программируемых логических матриц (ПЛМ) и топологии печатных плат  (ПП). Программные средства P-CAD позволяют автоматизировать процесс проектирования ПП: начать с конструирования  ПС, выполнить автоматическое или  интерактивное  размещение  радиоэлектронных  компонентов (РЭК) на ПП и автотрассировку соединений, провести проверку соответствия правилам проектирования, получить конструкторскую документацию и подготовить  информацию  для производства  плат на технологическом оборудовании. Таким образом, набор  взаимосвязанных  пакетов  обеспечивает сквозное проектирование РЭА. При этом используются уже  существующие в P-CAD библиотеки РЭК или пользователь может их расширить, дополнив новыми элементами.

Система P-CAD была разработана фирмой Personal CAD Systems, а затем    CADAM Company. Первой достаточно успешной версией данной системы был PCAD 4.5, затем был создан целый ряд версий данной системы, вплоть до версии PCAD 8.7. Все данные версии функционировали в MS DOS. Для этих версий использовалось также название Master Designer (MD) для того, чтобы отличить их от последующих версий  для Windows. Версии для Windows были созданы фирмой ACCEL Technologies, поэтому данные версии получили новое название ACCEL EDA. Затем, когда система PCAD перешла к фирме Protel International, системе было возвращено название P-CAD 2001. 

СИСТЕМА PCAD 4.5 (MASTER DESIGNER)

          Система P-CAD характеризуется следующими основными свойствами:

             - до 50 слоев, определяемых пользователем;

            - сетка, определяемая пользователем с шагом (в дюймах ) 0.001" (0.0254);

            - перемещение (обмен) выводов, вентилей и компонентов;

            - перемещение (сдвиг) в реальном времени компонентов, прямоугольников, окружностей и дуг;

            - автоматическое ведение журнала команд каждого сеанса редактирования;

            - возможность использования макросов, определяемых пользователем.

           Каждая  спроектированная печатная плата может включать:

            - 500 компонентов;

            - 1000 связей;

            - 6000 выводов  РЭК;

            - 50 слоев;

            - размер  печатной платы до 60"х60" (1524x1524mm) при масштабе 1:1;

            - разрешающая способность ширины  проводников  и  расстояний               0.001".

ОБЩАЯ СТРУКТУРА СИСТЕМЫ

          В системе P-CAD можно  выделить  следующие взаимосвязанные подсистемы:

            - подсистема входного проектирования;

            - подсистема проектирования печатных плат;

            - подсистема проектирования ПЛМ;

            - подсистема моделирования;

            - интерфейсы системы;

            - библиотека радиоэлектронных компонентов.

Каждая из этих подсистем включает в себя несколько взаимосвязанных  пакетов программ.

В каталоге (разделе, директории) системы  P-CAD размещаются следующие подкаталоги:

EXE - каталог, в котором размещаются все исполнительные файлы системы;

DRV - каталог, в котором располагаются драйверы системы;

SYM - каталог, в котором располагаются символьные элементы;

PRT - каталог, в котором располагаются технологические изображения элементов.

Каталоги пользователя (проекты) с произвольными именами.

Проектирование начинается с создания каталога пользователя. Затем в этот каталог копируется заготовка файла принципиальной схемы *.SCH, символьные и технологические файлы элементов (*.SYM и *.PRT), заготовки печатной платы *.PCB и т.д. Желательно, чтобы все файлы для схемы и платы в целом, относящиеся к одному проекту, имели одинаковое имя.

Практически все графические редакторы, программы  и утилиты системы требуют конфигурирования, которое вызывается из начального меню. При конфигурировании указывается имя каталога пользователя с полным путем.

3. Объект исследования. Система автоматизированного проектирования печатных плат P-CAD для MS DOS
ПОДСИСТЕМА ВХОДНОГО ПРОЕКТИРОВАНИЯ

Пакеты подсистемы имеют следующее назначение и краткую характеристику:

PC-CAPS  -  предназначен  для  проектирования   принципиальных      электрических схем РЭА и создания образов радиоэлектронных компонентов (РЭК).

[image: image2.png]simp [DETL

FILE] 15
| Y S
< SAELEL
L0 ENTR
B DR
BSY HE
L@ AT
T
2 HOUE
2 ROT
2
2

oY
DEL

R

22 (P 6
287w 2
WIN - REDR
ST AL
WR P

Select uiew center...
10°18 55 148 -39




Рис.3.1. Пример формы рабочего поля редактора PC-CAPS.

При этом формируется база данных электрических соединений и связей: для принципиальных схем файл с расширением .SCH; для радиоэлектронных компонентов (РЭК) -  файл  с  расширением  .SYM, эти вновь  созданные РЭК  используются в  следующих этапах проектирования принципиальных схем. Имеются средства редактирования и коррекции. Все функции пакета реализуются с помощью команд МЕНЮ в  интерактивном режиме. На рис.3.1. приведен пример рабочего поля редактора PC-CAPS. 

Особенностью системы PCAD является то, что в данном и в других графических редакторах, при выборе пунктов меню клавиатурой для подтверждения выбора используется клавиша "Пробел", в при выборе мышкой - правая кнопка мышки. Клавиша "Ввод" и левая кнопка мышки используется для выхода из режима выбора.

Утилита PC-NODES извлекает список электрических соединений из схематической базы данных, созданной  посредством  PC-CAPS, или  из базы данных печатных  плат, созданной  посредством  PC-CARDS (файл .PCB). При этом присваиваются имена неименованным связям и создается таблица соединений. Результат  работы - файл .NLT. Выходной список соединений  потом  может  быть  входным  для  PC-LINK,  PC-FORM, PC-PACK,      PRESIM, PC-ERC и интерфейсным программам.

Утилита PC-LINK  из нескольких взаимосвязанных таблиц (списков) соединений, находящихся в нескольких  базах  данных, создает единую базу данных  для  принципиальной  схемы, состоящей  из нескольких листов. Выходной файл имеет расширение .xnl. Он может быть входным для PC-PACK, PC-FORM, PRESIM и другим интерфейсным программам.

Утилита PC-ERC позволяет выполнить до десяти различных проверок проектирования  схемы.

ИНТЕРФЕЙС С ПОДСИСТЕМОЙ ПРОЕКТИРОВАНИЯ ПЕЧАТНЫХ ПЛАТ

Утилита PREPACK преобразует  созданный пользователем текстовый файл (с  расширением .FIL) из формата ASCII в двоичный формат (файл с расширением .LIB). Исходный  файл (.FIL) содержит  список используемых в схеме компонентов (логических элементов) из  библиотеки символьных компонентов (.SYM). Выходной  файл      (.LIB) содержит двоичное описание РЭК , используемых в принципиальной схеме и является входным файлом для PC-PACK.

Утилита PC-PACK читает таблицу соединений (.XNL) электрической схемы из   базы данных электрических схем, двоичный ссылочный файл используемых      в схеме компонентов (.LIB), файл базы данных печатной платы (.PCB) и файл компонентов печатной платы (.PRT). Она выводит следующее:

- базу данных печатной  платы (.PCB) с логическими вентилями,      упакованными по кристаллам микросхем и соединенными согласно предварительному размещению на плате; 

- список  физических соединений  базы данных  печатной  платы   (.pnl);

- командный  файл  упаковки  (.cmd), содержащий информацию об упаковке  вентилей электрической  схемы в физические  микросхемы для      обратной связи с исходной базой данных электрической  схемы;

- двоичный файл списка  соединений схемы  .PKG с номерами упакованных выходов элементов ссылочными обозначениями, присвоенными каждому компоненту для ввода в  интерфейсные программы.

Утилита PC-BACK  считывает  команды  упаковки элементов (.cmd) и отчет      размещений (.rpt), созданные соответственно в PC-PACK и в PC-CARDS,      а затем генерирует  обратный ссылочный  файл (.bka), который  может быть введен в PC-CAPS для обновления или изменения исходной схемы с учетом возможных изменений в PC-PLACE или PC-CARDS.

Программа PC-NLC сравнивает и выдает отчет о несоответствии электрических      соединений между двумя таблицами соединений. PC-NLC является гибкой      программой, созданной для  сравнения нескольких  комбинаций списков      соединений. 

ПОДСИСТЕМА ПРОЕКТИРОВАНИЯ ПЕЧАТНЫХ ПЛАТ

Графический редактор PC-PLACE, используя упакованную базу данных (файл .PKG, созданный с PC-PACK), выполняет  в  автоматическом или ручном (интерактивном) режиме размещение всех РЭК на ПП. Дополнительно (в тех же режимах) обеспечивает  средствами  векторов  направленности, изображения  гистограмм и связок цепей для анализа  и оптимизации размещения.

Программа PC-ROUTE читает файл (.PLC) базы данных, содержащей физическое размещение РЭК, упаковочную и логическую информацию и выполняет автотрассировку ПП. Пользователь может указать ряд параметров и стратегию трассировки:

Программа PC-CARDS это интеллектуальный графический редактор топологии  проектируемой ПП. Меню редактора включает набор команд для черчения, редактирования, вращения, копирования, уничтожения, перемещения и ввода компонентов, цепей и площадок. Многие из этих команд оперируют как с одиночными элементами, так и с их группами.

ПРОГРАММЫ ВВОДА-ВЫВОДА

Программа PC-PRINT считывает данные  из  плоттерного  файла, созданного  с  PC-CAPS, PC-CARDS или PC-PLACE и преобразует  его в инструкции (команды) принтера (мозаичного печатающего устройства).

Программа PC-PLOTS считывает  данные  из  плоттерного файла, созданного с PC-CAPS, PC-CARDS, или PC-PLACE и преобразует его в инструкции (команды) плоттера (чертежного устройства). 

Программа PC-FORM преобразует двоичный формат файла  со списком соединений в файл формата кодов ASCII в виде отчетов и справочной информации. Для этого она использует файлы, созданные с  PC-LINK, PC-NODES и PC-PACK. Отчеты могут содержать информацию о компонентах, упаковке, узлах,  проводниках или как список использованных материалов.

Программа PDIF-OUT преобразует базу данных P-CAD в формат PDIF  (*.PDF). Данный формат можно использовать для передачи файлов схем, плат и компонентов в более поздние версии P-CAD.

Программа  PDIF-IN читает формат PDIF  (*.PDF) и преобразует его в базу данных P-CAD (файлы .SYM, .SCH, .PRT, .PCB).

ИНТЕРФЕЙС ПРОИЗВОДСТВЕННЫХ СИСТЕМ

Программа PC-DRILL считывает базу данных ПП (файл .PCB) и преобразует его в файл с форматом данных для сверлильного станка с ЧПУ.

Программа PC-PHOTO считывает данные из плоттерного файла и преобразует их в инструкции фотоплоттера (фотокоординатографа). Эти инструкции вводятся непосредственно или косвенно (с диска) в фотоплоттер, который считывает команды черчения, размеров аппаратуры, выдержки и чертит фотошаблон.

ПОДСИСТЕМА МОДЕЛИРОВАНИЯ

Программа PRESIM преобразует двоичную базу данных схемы (файл и /или файлы .NLT, .XNL) в формат совместимый с пакетом PC-LOGS.

Программа PCMODEL компилирует модель поведения PC-LOGS. Скомпилированная  модель добавляется к исследуемой базе данных препроцессором (пакетом PRESIM).

Программа PC-LOGS выполняет логическое моделирование базы данных.

Программа POSTSIM используется для подготовки и просмотра результатов моделирования.

БИБЛИОТЕКА РАДИОЭЛЕКТРОННЫХ КОМПОНЕНТОВ

Библиотека радиоэлектронных компонентов базируется на общепринятых стандартах. Графический образ технолгической части РЭК использует его стандартные размеры, цоколевку  и  расстояния между выводами, расположение текста в соответствии с ANSI  стандартом. Где возможно для графических образов РЭК применяется IEEE стандарт.

Каждый компонент библиотеки имеет свой символьный графический      образ РЭК (символьная часть, обозначаемая  в библиотеке с расширением .SYM) и технологический (физический)  образ  РЭК (упакованная по кристаллам микросхем часть, обозначаемая расширением  .PRT). То  есть, библиотека РЭК состоит как бы из двух частей - символьного (.SYM ) и  технологического (физического) (.PRT)  графического представления РЭК.

Стандартная библиотека, представляемая с системой включает РЭК      (.SYM и .PRT часть) типа TTL, CMOS, линейные, дискретные, микропроцессоры семейства Intel, Motorpla, Zilog и другие. В  целом библиотека содержит более 2000 компонентов.

Кроме того, пользователь, работая в символьном режиме, посредством PC-CAPS или PC-CARDS может дополнять библиотеку новыми РЭК. В PC-CAPS создается .SYM часть, а в PC-CARDS создается .PRT часть РЭК.

4. Задание на работу
Каждый студент получает от преподавателя индивидуальное задание на разработку схем блоков и печатных плат.

5. Порядок выполнения работы

Студент выполняет принципиальную схему в системе P-CAD, а затем осуществляет ее трассировку и получает чертеж печатной платы. 
6. Содержание отчета
Отчет по лабораторной работе должен содержать изображение разработанных студентом схем и печатных плат в соответствии с выданным ему заданием.   
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Практическая работа №2
Разработка принципиальных электрических схем в автоматизированной системе проектирования печатных плат
1. Цель и задачи работы 

Изучение системы проектирования печатных плат PCAD-2001 и приобретение навыков разработки принципиальных схем электронных блоков с использованием данной системы. 
Задачей работы является выполнение принципиальной схемы выданного преподавателем узла в системе проектирования печатных плат PCAD и редакторе SCHEMATIC.  

2. Общее описание системы проектирования PCAD-2001
          Система PCAD 2001 характеризуется следующими основными свойствами:

             - до 99 слоев, определяемых пользователем;

            - сетка, определяемая пользователем с шагом в дюймах (0.0001"), милах (1 мил = 0,001"=0,0254 мм) или мм (0.001 мм=1 мкм);

            - простое перемещение (обмен) выводов, вентилей и компонентов;

            - простое перемещение (сдвиг) в реальном времени компонентов, прямоугольников, окружностей и дуг;

           - "горячая" связь между редакторами, изменение печатной платы одновременно с изменением принципиальной схемы;

            - возможность использования макросов, определяемых пользователем.

           Каждая  спроектированная печатная плата может включать:

            - количество компонентов в проекте не ограничено;

            - 64 000 цепей в проекте;

            - 999 выводов в одном РЭК;

            - 99 слоев;

            - размер  печатной платы до 60"х60" (1524x1524mm) при масштабе 1:1;

ОБЩАЯ СТРУКТУРА СИСТЕМЫ

          В системе PCAD 2001 можно  выделить  следующие взаимосвязанные подсистемы:

· подсистема проектирования принципиальных схем Schematic;

· подсистема проектирования печатных плат PCB;

· менеджер библиотек Library Manager (Library Executive);

· упрощенный трассировщик Quick Route;

· трассировщик Specсtra;

· упрощенный графический редактор Relay;

· анализатор электрических характеристик печатных плат Signal Integrity.

· и т.д. 

Аналогично системе PCAD для MS DOS принципиальные схемы сохраняются в файлах *.SCH, печатные платы - в файлах *.PCB. Однако отдельных файлов символов и технологических изображений компонентов и соответствующих отдельных библиотек в новых версиях PCAD не создается. Вся информация о компоненте хранится в общих библиотеках в файлах с расширением LIB.

3. Объект исследования. Описание редактора SCHEMATIC
Графический редактор Schematic имеет удобный стандартный интерфейс пользователя. Фрагмент окна данного редактора представлен на рис. 3.1. Выбор осуществляется традиционно левой кнопкой мышки. Клавиша со стрелкой позволяет выбрать любой объект. Его можно переместить при нажатой кнопке мышки, или удалить клавишей DEL.  
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Рис.3.1. Фрагмент окна редактора Schematic

Пользуясь меню "Размещение" (Place) или клавиш в левом вертикальном меню в схему вставляются символы компонентов, цепи, шины и т.д. Прежде, чем вставить компонент, необходимо подключить соответствующие библиотеки. Для работы в данном и других редакторах следует запомнить некоторые понятия, встречающиеся в их меню:

PIN - вывод компонента;

PAD - контактная площадка вывода компонента;

NET - цепь;

Wire - провод, линия, цепь;

BUS - шина;

GATE - секция компонента (если компонент содержит, например, несколько логических элементов);

RefDes - позиционное обозначение (атрибут компонента), например DD12, VT3 и т.д, здесь DD и VT - префиксы позиционных обозначений;

Type - тип компонента  (атрибут компонента), например КР580ВМ80. 

Для поворота объекта необходимо выбрать его и нажать на клавишу "R", при каждом нажатии компонент будет поворачиваться на 90 градусов.  При повороте вывода компонента необходимо дополнительно нажимать на левую кнопку мышки.

При размещении шин каждая линии шины обозначается с помощью вставки порта (Place > Port). Порт на схеме выглядит в виде таблички с именем и номером линии. Удобнее выбирать форму порта, встроенную в линию (компактнее) - горизонтальную. При вставке портов можно установить режим автоматического инкрементирования его номеров. Все вводимые цепи автоматически получают цифровые номера, но любой цепи может быть присвоено и любое имя по усмотрению разработчика путем вставки порта. Естественно, что имена цепей используются при создании схемы с разрывами на графических изображениях цепей или при размещении шин.

После настройки  конфигурации  P-CAD  Schematic  приступают к созданию принципиальной схемы.

Загрузка библиотек. Перед нанесением на схему символов компонентов по команде Library>Setup обеспечивается доступ к необходимым библиотекам. Нажав клавишу Add, добавляют имена библиотек в список открытых библиотек (Open Libraries). С помощью клавиши Delete удаляют библиотеки из этого списка, чтобы освободить место для других. С помощью клавиш Move Up, Move Down изменяют порядок их расположения в списке (нужно учитывать, что при поиске компонентов библиотеки просматриваются в списке в направлении сверху-вниз).
Размещение компонентов на схеме. В режим размещения символов компонентов на схеме переходят по команде PIace>Part[image: image4.png]


. После этого щелчок курсором в любой точке схемы открывает меню выбора компонента.
На панели Library указывается имя одной из открытых библиотек, список ее компонентов выводится в окне Component Name. Имя нужного компонента выбирают из этого списка или вводят в верхней строке (достаточно ввести одно или несколько первых символов имени, чтобы курсор переместился в указанную позицию). Нажатие клавиши Browse позволяет просмотреть графическое изображение символа компонента. При создании символа компонента в графе Alternate можно задать несколько альтернативных вариантов: Normal — нормальный, DeMorgan — обозначение логических функций, IEEE — в стандарте Института инженеров по электротехнике и электронике. В библиотеках, поставляемых вместе с P-CAD EDA, альтернативные варианты реализованы для многих, но не лля всех цифровых ИС (пользователи могут дополнить их по своему усмотрению, придерживаясь отечественных стандартов).
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Рис. 3.2. Загрузка библиотек (а) и выбор символа компонента (б)

В графе Num Parts указывается общее число секций компонента (изменять их на этом этапе нельзя). Например, ИС 564ЛА7 имеет 4 логических элемента (секции) 2И-НЕ.

В окне Part Num по умолчанию указывается номер секции 1, но при необходимости его можно изменить перед размещением символа компонента на схеме.

Нажатие клавиши Query активизирует средства поиска компонента в открытых библиотеках. Сначала в диалоговом окне Query  в столбцах Criteria задают критерии поиска и в столбце Show отмечают, какие характеристики найденных компонентов нужно отображать в таблицах результатов поиска). При задании критериев поиска используются следующие операторы:

= — в точности равно. Если используются символы обобщения * или ?, то проверяется равенство текстовых переменных;

< — меньше, чем;

> — больше, чем;

<= — меньше, чем или равно;

>= — больше, чем или равно;

<> — не равно;

IsLike — при использовании символов обобщения IsLike означает «подобно». Например, IsLike 5* может быть равно 50, 510, 5 и т. п.;

IsNotLike — при использовании символов обобщения IsNotLike эквивалентно «не равно». Например, IsNotLike 5* может быть 14, 20 или 42, но не 50, 510 или 5;

Exist — атрибут существует;

NotExist — атрибут не существует;

AnyValue — атрибут существует и имеет некоторое значение;

NoValue — атрибут существует, но значение ему не присвоено.
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Рис. 3.3. Задание критериев поиска компонента по команде Query (а) и результаты поиска (б)

Позиционные обозначения компонентов на схеме проставляются автоматически. Например, если из импортной библиотеки интегральных микросхем ТТЛ серии 7400 последовательно размещать на схеме 4-секционную ИС 7408, то первый элемент приобретет позиционное обозначение U1:А. Префикс позиционного обозначения U назначен при создании компонента (при необходимости его можно заменить, например на DD), номер первого компонента 1 и имя первой секции А проставляются автоматически, т. е. первый элемент получит позиционное обозначение U1:А. Второй элемент получит позиционное обозначение U1:В, третий — U1:С, четвертый — U1:D, пятый — U2:А и т. д. Для изменения назначенного в библиотеке префикса позиционного обозначения его надо указать в поле RefDes в явном виде. Для компонентов, состоящих из одной секции, имя секции не проставляется.
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Рис. 3.4. Автоматическая простановка позиционных обозначений многосекционных и односекционных компонентов

После выбора в меню Place>Part  нужного компонента и введения всех необходимых параметров нажимают ОК — курсор примет форму перекрестья с разрывом в центре для точного позиционирования в узлах сетки. Непосредственное размещение символа компонента на схеме выполняется после щелчка курсором в любой точке рабочего окна. До тех пор, пока не отпущена левая кнопка мыши, символ перемещается по экрану. Он поворачивается на 90° в направлении против часовой стрелки и зеркально отображается нажатием клавиш R и F соответственно. Повторный щелчок курсором размещает на схеме очередную копию символа выбранного компонента, присваивая ему следующее позиционное обозначение, которое одновременно выводится в строке информации. Например, после ввода первого символа ИС 1564ЛАЗ, которому присваивается позиционное обозначение DD1:1, следующий символ приобретет позиционное обозначение DD1:2 и т. д. Для увеличения на единицу номера секции компонента перед размещением символа нажимают клавишу Р, а для увеличения позиционного обозначения — клавишу D. Уменьшить эти значения можно одновременным нажатием клавиш Shift+P или Shift+D. Нажатие правой кнопки мыши или Esc прекращает ввод символов.

В режиме Edit>Select [image: image10.png]


 щелчок курсора в любой точке внутри контура символа компонента производит его выбор с возможностью перемещения, поворота и удаления символа вместе с принадлежащими ему атрибутами. Нажатие клавиши Shift и удерживание ее до щелчка курсора позволяет выбрать отдельный элемент символа: вывод, элемент графики, позиционное обозначение и др.

3. Размещение электрических цепей. После выбора команды Place>Wire [image: image11.png]


 курсор принимает форму перекрестья. Щелчком мыши отмечается начальная точка цепи. Каждое нажатие левой кнопки мыши фиксирует точку излома. Нажатие клавиши О до отпускания левой кнопки мыши изменяет угол ввода линии из числа разрешенных (задаваемых в меню Options>Configure), нажатие клавиши F изменяет ее ориентацию. В связи с тем, что на схеме обычно преобладают горизонтальные или вертикальные цепи, в меню Options>Configure достаточно включить только режим ввода ортогональных цепей 90/90 Line-Line. Завершается ввод цепи нажатием правой кнопки мыши (или Esc).

Ширина прокладываемой цепи устанавливается по команде Options>Current Wire: Thick — широкая (шириной 0,381 мм = 15 мил), Thin — узкая (шириной 0,254 мм = 10 мил) и User — задаваемая пользователем (в пределах от 0,1 до 100 мил).

Неподсоединенные выводы компонентов и открытые концы цепей, не подсоединенных к другим цепям или к выводам компонентов (Open End, рис. 2.3), помечаются квадратиками, которые гаснут после выполнения электрического соединения. Причем если два вывода компонентов соприкоснутся, то между ними образуется электрическое соединение, сохраняющееся при раздвижении компонентов.

Если при перемещении цепи, имеющей присвоенное ей ранее имя (не системное имя типа NETxxxxx), она соприкоснулась с другой такой же цепью, открывается диалоговое окно для выбора имени объединенной цепи или отказа от выполнения операции. При одновременном соединении нескольких цепей (это возможно при их перемещении в окне) выводится сообщение об отказе от их объединения, что позволяет продолжить перемещение этих цепей или вернуться к исходному состоянию по команде Undo.
Включение в цепь дополнительной точки излома для последующего редактирования выполняется по команде Rewire>Manual [image: image12.png]



Обратим внимание, что в строке информации выводится присваиваемое автоматически имя размещаемой цепи, причем при буксировке курсора до отпускания правой кнопки мыши дополнительно выводится расстояние по осям X, Y до предыдущей точки излома, например Net: NET00003, dX=2.50, dY=0.00. Здесь NET00003 — присваиваемое автоматически имя цепи. Следующая цепь получит имя NET00004.
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Рис. 3.5. Прокладка цепей 

Присвоить цепи другое имя можно двумя способами. Во-первых, индивидуально выбрать каждую цепь и щелчком правой кнопки мыши открыть в меню редактирования пункт Properties (Свойства). На экране появится информация о выбранной цепи. На закладке Net можно изменить имя цепи, заменив на строке Net Name назначенное системой имя другим, например заменить NET00001 на А1. Это имя будет видимым, если включить на закладке Wire переключатель Display. Тип и размер шрифта имени указывают после нажатия на клавишу Text Styles. На закладке Net можно также задать значения различным атрибутам цепи, нажав на клавишу Net Attrs.

Во-вторых, можно упростить ввод имен групп цепей, имеющих однородные имена типа D1, D2, ..., и их переименование. Для этого нужно выбрать команду Utils>Rename Nets, щелкнуть курсором в любой точке схемы и в открывшемся меню на строке Net Name ввести префикс имени, например In, и выбрать параметр Increment Name (режим приращения имени). После закрытия этого меню щелчком курсора по первой цепи ей присваивается имя In0, по второй — In1 и т. д. Чтобы начать нумерацию цепей не с нуля, нужно начальное имя ввести в явном виде, например DATA5. Тогда первая цепь получит имя DATA5, вторая — DATA6 и т. д.

Обратим внимание, что если к цепи подсоединить компонент заземления GND, то она автоматически получит имя GND, так как выводу компонента заземления присвоен тип Power, что обеспечивает автоматическую замену имени цепи, к которому он подключен, на имя этого компонента. Этот же прием часто используется для подключения цепей питания и других стандартных цепей.

Обычно имя цепи перемещается вместе с самой цепью, однако если в режиме выбора нажать клавишу Shift и затем щелкнуть на имени цепи курсором, то имя цепи будет перемещаться отдельно.

Электрическое соединение пересекающихся цепей обозначается точкой «пайки» (Junction), которая автоматически проставляется на Т-образных соединениях.
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Рис. 3.6. Меню редактирования имен и атрибутов цепи (а), размеров шрифта и визуализации имени цепи (б) и переименования цепи (в)

Чтобы проставить точку соединения пересекающихся цепей, нужно при вводе второй цепи щелкнуть курсором в точке пересечения и затем продолжить ее построение.

4. Размещение шин. Выбор команды Place>Bus [image: image17.png]


 активизирует режим ввода шин. Щелчком курсора отмечают начало шины и точки ее излома. Построение шины завершается нажатием правой кнопки мыши или Esc.
После этого по команде Place>Wire размещают цепи. При рисовании цепи, входящей в состав шины, ее начало или конец должны располагаться в любой точке шины. При этом при подключении к шине автоматически изображается излом цепи под углом 45° (стиль этого изображения устанавливают в меню команды Options>Display).
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Рис. 3.6. Диалоговые окна команд Place>Port (а) и Bus Properties (б)

Замечание. Шина изображается на схеме линией шириной 30 мил = 0,76 мм и изменить ее ширину нельзя. Однако при необходимости можно поверх нее нарисовать линию нужной ширины по команде Place>Line.

Имена цепей, образующих шину, задаются подключением к цепям по команде

Place>Port [image: image20.png]


 специальных портов (командами Edit>Nets и UtiIs>Rename Nets в этих целях пользоваться не рекомендуется). После выбора команды Place>Port щелчком мыши на любой точке схемы открывается изображенное на меню выбора порта. На расположенной вверху строке Net Name указывают имя первой цепи, например D1. Если включить переключатель Increment Port Name («Имя порта расширения» в неудачном переводе), то при размещении портов они автоматически получат имена Dl, D2, D3 и т. п. Наиболее удобно включать порт в разрыв цепи, для этого он должен иметь два вывода (Two Pin) и располагаться горизонтально (Horizontal). Если изображение порта в виде прямоугольника не устраивает, то выбирается порт с одним выводом (One Pin), расположенный вертикально (Vertical) и не имеющий рамки (None), в результате имя цепи (порта) будет расположено над ней. После закрытия меню нажатием ОК порты подключаются последовательными щелчками мыши по именуемым цепям (текущее имя цепи отображается в строке информации). Именованные таким образом цепи являются глобальными (Global), их можно переименовывать по командам Edit>Nets и Utils>Rename Nets. Видимость имени шины устанавливается с помощью переключателя Display меню Bus Properties.
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Рис. 3.7. Графическое изображение шины
[image: image22.png]4 P-CAD 2001 Schematic - [Untitled1]
L) Gaiin Mpaera Bra

)
=) ey
iz

m





Рис. 3.8. Основная надпись по ЕСКД

Создание и заполнение угловых штампов. Файлы угловых штампов (основных надписей) создаются как файлы схем, но им присваивают расширения имени *.TTL. На рис. 3.8 приведен пример углового штампа. Угловой штамп в стиле P-CAD: ADT_A3A4.TTL, поставляемый вместе с P-CAD в каталоге P-CAD 2001\TITLES. В подобные файлы вместе с угловым штампом можно поместить и форматку чертежа (см. файлы A.TTL, A0.TTL — A4.TTL). Эти файлы размещаются на чертеже двояко. Во-первых, их можно загрузить по команде FiIe>Open и затем приступить к созданию схемы. Во-вторых, имена этих файлов можно указать в диалоговом окне команды Options>Configure после нажатия на панель Edit Title Sheets. Непосредственный выбор имени файла производится после нажатия на панель Select, изображение рамки наносится на чертеж после выбора опции Display Border. Введенные изменения настроек сохраняются после нажатия на панель Modify. Надписи и линии углового штампа после подключения его к схеме по второму способу становятся недоступными для редактирования (и это очень удобно). Пользователь может только заполнить строки данных, заключенные в фигурные скобки, например {Author} — автор. Строки данных наносят по команде Place>Field, в меню которой вводятся данные двух типов.

1.
Информация о текущих данных, которые автоматически обновляются:

Current Date — текущая дата;

Current Time — текущее время; 

Filename — имя файла; 

Number of Sheets — число листов; 

Sheet Number — номер текущего листа.

2.
Данные, заполняемые при редактировании схемы: {Author} — фамилия автора;

{Date} — дата создания;

{Revision} — дата изменения;

{Time} — время создания;

{Title} — название проекта.

Для заполнения данных второго типа открывают закладку Fields диалогового окна команды File>Design Info. Предварительно по команде Options>Text Style определяют стиль текста на основе одного из кириллических шрифтов и делают его текущим (Current Text Style). Содержание отдельных граф заполняется после нажатия на панель Properties, ввод новых граф — на панель Add (новая информация сразу же передается в диалоговое окно команды File>Design Info и ее можно наносить на чертеж). Дополнительная текстовая информация наносится непосредственно на схему по команде Place>Text A.

По такому же принципу может быть создан угловой штамп (основная надпись) согласно ЕСКД.
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Рис. 3.9. Заполнение учетных данных о проекте
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Рис. 3.10. Соединитель страниц

Размещение проекта на нескольких листах. Для создания дополнительных листов схемы по команде Options>Sheets на закладке Sheets в поле Sheet Name последовательно определяют имена второго и последующих листов схемы, каждый раз нажимая кнопку Add. Наиболее естественно именовать листы схемы Sheetl, Sheet2 и т.д. (при этом все листы находятся в одном файле). В дальнейшем листы схемы переключаются в строке состояний. Перед переносом части схемы на другой лист необходимо к выводу компонента, связь от которого должна быть проложена на другой лист, подключить порт, имеющий один вывод (соединитель страниц), и присвоить ему имя цепи. На другой странице должен быть размещен порт стем же именем для обеспечения электрического соединения.
Добавление атрибутов цепей и компонентов. Для добавления атрибута цепи (или компонента) выбирается цепь (или компонент) и после открытия щелчком правой кнопки мыши меню редактирования указывают в нем пункт Properties. Затем по команде Add добавляют атрибуты, как показано на рис. 2.16, где введен атрибут ширины проводника Width, который будет принят во внимание автотрассировщиком. С помощью выключателя Visible каждый атрибут может быть сделан видимым или невидимым на схеме. Для управления видимостью на экране всех однотипных атрибутов по команде Options>Display атрибуту можно назначить индивидуальный цвет или цвет фона (чтобы он был не виден). Аналогично при выводе схемы на печать по команде File>Print>Print Options указывают цвета атрибутов и других объектов.

[image: image25.png]Attributes

Atributes

|





Рис. 3.11. Редактирование атрибутов цепей

Таким образом назначают цепям или компонентам индивидуальные атрибуты. Атрибуты общего характера вводят по команде Place>Attribute.

Обратим внимание, что с помощью атрибутов, задаваемых пользователем (user defined), можно при создании библиотек компонентов указывать* наименования технических условий, содержание драгоценных металлов и другие данные согласно ЕСКД, которые будут занесены в отчеты о проекте.

Поиск объектов. Выберем компонент и щелчком правой кнопкой мыши развернем всплывающее меню, в которой укажем команду Highlight Attached Nets — в результате высвечиваются все цепи, подключенные к этому компоненту. Для поиска на схеме компонента выполняют команду Edit>Parts и в открывшемся меню со списком всех компонентов курсором указывают имя конкретного компонента. После нажатия на кнопку Jump этот компонент ярко высвечивается, даже если он находится на другом листе схемы (листы схемы переключаются автоматически). Аналогичную процедуру выполняют при выборе цепи в меню команды Edit>Nets. В списке цепей можно вывести имена всех цепей (All Nets) или только глобальных цепей (Global Nets Only), а также имена шин (Bus). По команде Jump to Node курсор указывает на схеме узел данной цепи, предварительно выбранный в списке Nodes, в котором приняты обозначения: U6-9 — это вывод 9 компонента U6.


Редактирование схемы. Для перемещения компонента или цепи нужно выбрать их щелчком курсора и затем перемещать движением мыши. Если одновременно нужно переместить несколько объектов, например компонент и связанные с ним сегменты цепей, то дополнительные объекты выбирают щелчком курсора с одновременным нажатием и удерживанием клавиши Ctrl. Выделенная группа объектов перемещается как единое целое. Если после перемещения сегментов цепей часть из них будет расположена неаккуратно, щелчком курсора выбирают отдельный сегмент и перемещают его вершину. Выбор для редактирования элемента сложного объекта (например, позиционного обозначения компонента) производится щелчком левой клавиши мыши при одновременном нажатии кнопки Shift.

Перед перемещением группы объектов полезно щелчком правой кнопкой мыши выбрать команду Select Point для нанесения точки привязки (имеет форму перекрестья, заключенного в квадрат). При перемещении объектов в строке информации выводятся значения смещения точки привязки dX, dY относительно ее первоначального расположения.

Скопировать выделенную группу объектов можно последовательным выполнением команд Edit>Copy, Edit>Past или, что более удобно, удерживанием клавиши Alt при перемещении мыши. При копировании группы объектов входящие в них глобальные цепи не изменяют своих имен (к глобальным относятся цепи, к которым подключены порты или выводы компонентов, имеющие тип Power), остальные цепи переименовываются. Компонентам присваиваются новые позиционные обозначения.

После размещения символов нескольких одинаковых компонентов всем им сразу можно присвоить одинаковые атрибуты. Например, выбрав несколько резисторов, после щелчка правой кнопки мыши в открывшемся меню выбирают команду Properties и вводят значение атрибута Value — в результате обновляются значения атрибутов Value всех выбранных резисторов.
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Рис. 3.12. Меню выбора цепей

Все однотипные компоненты удаляют следующим образом. В меню команды Options>Block Select нажимают клавишу Clear All (Очистить все) и двойным щелчком по выключателю панели Part окрашивают его в серый цвет. Затем нажимают на панель Part и в открывшемся меню на строке Туре вводят имя удаляемого компонента, например С2-6, и нажимают ОК. В заключение в графе Select Mode выбирают вариант Outside Block (вне блока). Возвратившись в рабочее окно, на любом свободном месте движением курсора создают прямоугольный блок, после чего все указанные компоненты оказываются выбранными. Удаляют их нажатием клавиши Delete.

Изменение позиционных обозначений. Перед завершением создания схемы целесообразно переименовать позиционные обозначения компонентов по команде Utils>Renumber. В меню этой команды выбирают объект перенумерации RefDes и порядок простановки позиционных обозначений Top to Bottom (сверху вниз) или Left to Right (слева направо), что не совпадает с требованиями ЕСКД. После нажатия на клавишу ОК позиционные обозначения перенумеровываются в заданном порядке. Перенумерация согласно ЕСКД производится вручную или с помощью специальной утилиты DBX.
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Рис.3.13. Меню команды перенумерации позиционных обозначений и выводов компонентов

Сохранение проекта. По команде File>Save отредактированный проект сохраняется в исходном файле, по команде File>Save As проект сохраняется в другом файле, причем предварительно можно выбрать его формат:

Binary Files — бинарный формат (расширение имени *.SCH);

ASCII Files — текстовый формат (расширение имени *.SCH).

Файлы обоих форматов имеют одно и то же расширение имени *.SCH. Бинарный формат более компактен и является основным, текстовый формат используют для обмена данными с другими программами.

Замечание. Некоторые параметры конфигурации схемного редактора заносятся в файл SCH.INI, к ним, в частности, относятся:

· список значений ширины линии;

· имена загружаемых библиотек;

· размер листа схемы.

Другие параметры хранятся в файле схемы (чтобы убедиться в этом, достаточно сохранить файл схемы в текстовом формате P-CAD ASCII и проанализировать его):

· система единиц;

· набор шагов сетки;

· стили текста;

· шаблоны отчетов.

Чтобы не вводить эти данные всякий раз для каждой новой схемы, рекомендуется завести один или несколько отдельных файлов, не имеющих графической информации, ввести типичные параметры и сохранить эти шаблоны схем под уникальными именами, например TEMPLATE_1.SCH и т. п. Тогда создание новой схемы будет начинаться с загрузки одного из таких файлов, устанавливающих необходимые параметры конфигурации.

Для передачи принципиальной схемы в редактор печатных плат PCB используется специальных файл списка соединений с расширением NET. Для этого используют команду Utils > Generate NetList  с выбором формата файла списка соединений ASCII или Tango.  

4. Задание на работу
Каждый студент получает от преподавателя индивидуальное задание на разработку  принципиальной схемы и разрабатывает ее с использованием редактора SCHEMATIC.

5. Порядок выполнения работы

Студент выполняет принципиальную схему в системе P-CAD. (редактор SCHEMATIC). При этом используется учебная библиотека компонентов Lib_09.lib
6. Содержание отчета
Отчет по лабораторной работе должен содержать изображение разработанной студентом принципиальной схемы.   
7. Список использованных источников

1. Инжиниринг электроприводов и систем автоматизации : учеб. пособие для вузов / М.П.Белов [и др.];под ред.В.А. Новикова, Л.М.Чернигова .- М. : Академия, 2006 .- 368с. (30 экз)
2. Стешенко, В.Б. P-CAD. Технология проектирования печатных плат : учеб. пособие для вузов / В.Б.Стешенко .- СПб. : БХВ-Петербург, 2003 .- 720с. (5 экз)

3. Покровский, Ф.Н. Материалы и компоненты радиоэлектронных средств : учеб. пособие для вузов / Ф.Н.Покровский .- М. : Горячая линия-Телеком, 2005 .- 350с. (10 экз)

4. Электротехнический справочник. В 4 т., Электротехнические изделия и устройства : в 4 т. / под общ.ред.:В.Г.Герасимова и др. — 9-е изд.,стер. — М. : Изд-во МЭИ, 2003 .— 518с. (4 экз) 
5. Предко, M. Справочник по PIC-микроконтроллерам / М.Предко;пер.с англ. — М. : ДМК Пресс, 2004 .— 512с. (2 экз)
6. Хетагуров, Я.А. Проектирование автоматизированных систем обработки информации и управления (АСОУИ : учебник для вузов / Я.А.Хетагуров .- М. : Высш.шк., 2006 .- 223с. (2 экз)
Практическая работа №3
Разработка компонентов с использованием менеджера библиотек.

1. Цель и задачи работы 

Изучение системы проектирования печатных плат PCAD с использованием менеджера библиотек LIBRARY MANAGER (LIBRARY EXECUTIVE) и приобретение навыков проектирования электронных блоков с использованием данной системы.

Задачей работы является создание новых компонентов электронных блоков с использованием графических редакторов и менеджера библиотек.
2. Описание менеджера библиотек LIBRARY MANAGER (LIBRARY EXECUTIVE)

Окончательно компонент создается и редактируется только в данном редакторе. Для этого сначала устанавливается необходимая библиотека, затем выбирается файл корпуса компонента, устанавливается количество секций и префикс позиционного обозначения. После этого становится доступной клавиша выбора символа компонента. Выбрав символ можно, нажав клавишу "Pins View"("Вид пина"), выйти в таблицу выводов компонента. В этой таблице можно отредактировать или заново разместить следующую информацию о выводах компонента:

Pad # - номер вывода по порядку;

Pin Des - номер вывода по цоколевке (физический номер вывода);

Gate # - номер секции;

Sym Pin # - номер вывода в пределах секции;

Pin Name - имя вывода;

Gate Eq - эквивалентные секции (обозначаются одинаковым номером);

Pin Eq- логически эквивалентные выводы (обозначаются одинаковым номером);

Elec Type - электрический тип вывода.

Для линий питания в графе Gate #  указывается PWR, графа Sym Pin # остается свободной, а в графе Pin Name указывается либо GND - земля (корпус), либо VCC - линия напряжения питания. 

3. Объект исследования. Создание многосекционного компонента
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Рис.3.1-Обозначение компонента
Опишем последовательность создания компонентов на примере интегральной схемы однородной структуры со штыревыми выводами 155ЛА3 – четырех логических элементов 2И-НЕ.
Структура библиотек

Интегрированные библиотеки содержат компоненты, корпуса и символы. Каждый компонент состоит из одной или нескольких логических секций, которые упаковываются в корпус. Несколько разных компонентов могут упаковываться в один и тот же типовой корпус.

Корпуса и символы, на которые имеются ссылки в компонентах, должны находится в одной и той же библиотеке.

Ссылки в разных компонентах на одни и те же корпуса и символы значительно экономят память, занимаемую библиотекой. Кроме того, редактирование типовых корпусов и символов сразу вносит изменения в графику всех родственных компонентов. Однако это представляет и некоторую опасность, если не контролировать связи между компонентами и графикой корпусов и символов.

В стандартную поставку P-CAD входит 56 интегрированных библиотек и три библиотеки стандартных корпусов PCBMAIN.LIB – корпуса дискретных компонентов и интегральных компонентов и интегральных схем со штыревыми выводами, PCBMT.LIB –корпуса дискретных компонентов и интегральных схем с планарными выводами, PCBCONN.LIB-разъемы. При их создании использованы соглашения о назначении имен корпусов, что облегчает поиск нужного корпуса. В помощью префикса «xx» в имени корпуса обозначают количество выводов. Принятые обозначения сведены в таблицу 1.

Таблица 1- каталог библиотек корпусов
	Название корпуса компонент
	Описание корпуса

	Библиотека PCBMAIN.LIB

	CAPxx
	Конденсаторы. Число xx – расстояние между центрами выводов, суффикс А-осевое располодение выводов, R радиальное, Р- по произвольному направлению

	DIPxx
	Корпус с двухсторонним расположением выводов. Суффиксы N или W Указывают на узкий или широкий корпус

	 DO-xx
	Диоды 

	FUSE
	Предохранитель

	GRIDRELAY-2x
	Реле

	INDxx
	Дроссель

	JMPxx
	Клеммные перемычки. Суффикс Т обозначает Т-образную форму

	JUMPER
	Двухклеммная перемычка

	LEDxx
	Светодиоды. Число xxx – расстояние между центрами выводами

	PBxxx
	Нажимные кнопки. Число xxx- расстояние между центрами выводов

	PGAxx/xx
	Многорядное расположение выводов (Pin Grid Arrays)/ перед косой чертой указывается число рядов, после неее число столбцов или строк в ряду.

	PLCCSOCKETxx
	Корпус с матричным расположением выводов

	POTxx
	Потенциометры. Суффиксы S или Т – различные формы корпусов

	REEDRLYxx
	Язычковые реле

	RESxx
	Резисторы. Число xx – расстояние между центрами выводов

	SIPxx
	Корпус с односторонним расположением выводов

	SW-DIPxx
	Переключатели с двухрядным расположением выводов

	TO-xx
	Транзисторы. В скобках указан порядок расположения выводов

	XTAL-OSC
	Кварцевые резонаторы

	ZIPxx
	Корпус с двусторонним расположением выводов, смещенных вправо

	Библиотека PCBSMT.LIB

	ССxx
	Конденсаторы

	DPAK
	Электрические конденсаторы

	LLC
	Корпус с четырехсторонним расположение выводов

	MELF1/4W
	Трубчатые резисторы

	MLLxx, SODxx
	Трубчатые резисторы, конденсаторы, катушки индуктивности или диоды

	PLCCxx
	Пластмассовый корпус. Суффикс А- тип корпуса по стандарту JEDEC, J- корпус квадратной формы, R- корпус прямоугольной формы, L- корпус большого размера, М- миниатюрный корпус

	QFPxx
	Корпус с четырехсторонним расположением выводов

	RCxx
	Резисторы

	SOxx
	Корпус с двустронним расположением выводов, малая ширина корпуса

	SOJxx
	Корпус с двусторонним расположением выводов, средняя ширина корпуса

	SOLxx
	Корпус с двусторонним расположением выводов, большая ширина корпуса

	SOTxx
	 Миниатюрные транзисторы или диоды

	TCxx
	Танталовые конденсаторы

	WWIND/A
	Катушки индуктивности

	Библиотека PCBCONN/LIB

	CONxxPIN
	Разъемы с однорядныи расположением выводов

	DBxx
	Миниатюрные разъемы. Суффиксы M и F – штыревые выводы и розетки, R- смещение выводов вправо

	DDxx
	Миниатюрные разъемы. Суффиксы M и А – штыревые выводы и розетки, R- смещение выводов вправо

	DINxx
	Разъемы типа DIN. Суффиксы M и F – штыревые выводы и розетки

	ECONxx/yy
	Разъемы с планарными выводами фипмы Texas Instruments. Число после косой черты – расстояние между центами выводов

	EDGExx/yy
	Разъемы с планарными выводами. Число после косой черты – расстояние между центами выводами

	IDCxx
	Вертикальные разъемы типа IDC. Суффикс R- смещение выводов вправо


Окно просмотра Sourse Browser открывается по команде View>Source Browser . в нем отражается дерево библиотек, открытых по команде Library>Setup. Каждая библиотека состоит из разделов Components, Patterns, Symbols. Двойной щелчок курсора мыши по символу или компоненту открывает окно просмотра их изображения. Щелчок правой кнопки мыши  по компоненту открывает всплывающее меню, содержащее две строки: open и place. Open открывает окно component information с предоставлением возможностей редактирования параметров компонента. Place  позволяет по дополнительному выбору разместить символ компонента на схеме или его корпус на ПП.

Команда Query имеется в составе P-CAD Executive и P-CAD Schematic, P-CAD PCB. С ее помощью производится поиск компонентов по набору их параметров. Поиск производится в библиотеке, предварительно выбранной в окне Sourse Browser. Сначала в диалоговом окне команды Query задается  набор критериев поиска. После нажатия в диалоговом окне Query производится поиск, результаты которого представлены в виде списка компонентов, удовлетворяющих заданным критериям.
Создание символа компонента в P-CAD Schematic.

Сначала по команде опции> конфигурации выбирают систему единиц и по команде опции>сетки устанавливают необходимый шаг сетки, в данном случае сетка метрическая, шаг сетки 5 мм.
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Рис.3.2- Устанавливаем систему единиц

Затем по командам размещение>линия , размещение>дуга рисуем контур символа линиями шириной 0,25 мм. Текстовые надписи наносятся по команде размещение>текст, выводы –по команде размещение>пин (дублирующая панель меню размещения находится с правой стороны экрана). В меню этой команды (рис.2)в графе характеристики отображения нужно включить опции имя пина и диз.пина (видимость на схеме имен и номеров выводов), в графе длина указать длину выводов (короткий -2,5 мм; нормальный-7,6мм; длинный-12,7мм; пользовательский - назначается пользователем)
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Рис.3.3  Свойства пина
После этого щелчками мыши размещают выводы символа. Вращение выводов на 90◦ выполняется нажатием клавиши R. В результате рисуется заготовка символа К155ЛА3(рис.3.5).
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Рис.3.4-рисуем контур символа

Далее по команде размещение>атрибуты размещают атрибуты RefDes и Type. Все выводы символа получают одинаковое позиционное  обозначение по умолчанию. Выводы нумеруют по команде утилиты>переименовать, (рис.3.5)
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Рис.3.5- Перенумерация выводов символа
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Таблица 3.2 –Типы выводов символа компонента

В графе тип выбирают режим нумерации выводов диз.пина по умолчанию и на стоках нач.номер и значение возрастания задаются начальное значение и приращение позиционных обозначений выводов. Для нумерации выводов их по очереди выбирают курсором, начиная с первого. В качестве точки привязки по команде размещение>точка обычно отмечают верхний левый вывод символа. При создании символа многосекционного компонента таким образом нумеруются только выводы первой секции, а выводы остальных секций нумеруются позже в таблице Pins View.

В заключении все объекты, относящиеся к символу компонента, выбираются в окне и выполняется команда его занесения в библиотеку библиотека>сохранить как. В меню этой команды выбирают имя одной их открытых библиотек (рис. 3.6), куда нужно занести созданный символ, и вводят его имя К155ЛА.
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Рис. 3.6- Сохранение в библиотеку

Создание корпуса 

Открываем P-CAD PCB. Устанавливаем библиотеку PCBMAIN.LIB. Подбираем корпус для нашего компонента. 
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Далее необходимо разруппировать корпус, выделяем корпус, затем нажимаем правка> уничтожить компонент. Выбираем компонент и сохраняем в библиотеку (аналогично сохранению символа).
Создание компонента с помощью Library Executive
После загрузки Library Executive выполняется команда компонент>новый, и в ее диалоговом окне указывают файл библиотеки, в которой ранее занесены корпус и символ компонента. Затем на экране выводится окно информация компонента(рис. 3.7)
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Рис. 3.7 Информация компонента

В нем сначала нажимают кнопку выбор шаблона для подключения граики корпуса компонента. В открывшемся окне из списка корпусов, помещенных в открытую библиотеку, выбирают нужный.

Затем вводят следующую информацию.

1. В строке число ворот указывают число секций, в данном случае-4.

Число выводов компонента проставляется на строке Number of Pins  автоматически.

В строке префикс указывается префикс позиционного обозначения компонента, в данном примере DD. В графе тип компонента выбирают тип компонента нормальный.
2. В графе стиль компонента для однородного компонента выбирают строку гомогенный.
3. В графе нумерация ворот выбираем числовой способ именования секций компонента буквенный(первая секция в графе Gate# в таблице получит номер 1, вторая 2 и т.д.). 
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Рис.3.8 – Информация компонента
Редактирование таблицы выводов компонента

Создание компонента завершается заполнением таблицы выводов, которая выводится на экран нажатием кнопки вид пина.  Это самая трудоемкая работа по созданию компонента.

Во-первых, нужно установить соответствие между номерами выводов всех секций Sym Pin# и позиционными обозначениями выводов корпуса Pin Des (порядковые номера выводов Pad Number обычно полагают равным Pin Des).

Сначала копируем содержание столбца Pad# в столбец Pin Des. Затем выделим курсором всю пустую строку 13, кроме ячейки Pin Des, и нажатием на клавишу ctrl+↑ переместить ее на строку 7. Затем в колонке Pin Name введем имена выводов первой секции. Для этого курсором выделим соответствующую ячейку и введем необходимую информацию, которая появляется на строке над таблицей. Нажатием на кнопку enter введенные данные переносятся в выделенную ячейку. Нажатием на esc отменяется ввод.

В графах Gate Eq и Pin Eq эквивалентным секциям и входным выводам каждой секции присваивается одинаковый код эквивалентности, в данном примере равный 1.
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Рис.3.9- Таблица выводов
В графе Elec.Type указывают тип вывода, используемый при поиске ошибок в принципиальных электрических схемах. Нажатием на правую кнопку мыши открывает список типов выводов(таблица ). 
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Рис 3.10- Таблица выводов
             Таблица 3- Выводы символов компонентов
	passive
	вывод пассивного компонента
 (не имеющего источников энергии)
	

	input
	входные выводы
	

	output
	выходные выводы
	

	bidirectional
	Двунаправленные выводы
	

	open-H
	открытий эмиттер ИС типа ЭСЛ
(к нему должен быть подглючне нарузочный резистор)
	

	open-L
	открытый коллектор ИС типа ТТЛ 
(к нему должен быть подключне нагрузочный резистор)
	

	passive-H
	пассивный компонент(обычно резистор), 
подключаемый к источнику питания (соответствует высокому 
логическому уровню
	

	passive-L
	пассивный компонент(обычно резистор),
 подключаемый к "земле" (соответствует низкому 
логическому уровню)
	

	3-state
	тристабильный вывод (имеет высокий и низкий
 логический уровень и уровень высокого импенданса)
	

	power
	подключение вывода питания или "земли".
 Назначение типа Power автоматически проставляет 
номер секции PWR в столбце Gate# таблицы выводов
(вместо PWR можно оставить пустую ячейку или ввести0)
	


Сохранение компонента в библиотеке.

Перед сохранением в библиотеке компонента необходимо выполнить команду проверки компонент>подтвердить. При обнаружении ошибок выводятся информационные сообщения, например Missing Lin Des in row 1. Only ‘unused’ pads are allowed to have a blank Pin Des. (пропущен номер вывода в строке 1. Только неиспользуемые выводы могут не иметь информации в графе Pin Des)
Или 

The gate equivalence specified in Component Information for gate 4 does not match the pin’s gate equivalence specified in row 14.

(код логической эквивалентности, введенный в окно Component Information для секции 4, не соответствует коду логической эквивалентности, указанному строке 14).
Если ошибок не обнаружено, программа сообщает  «no  error found».
После исправления всех ошибок выполняется команда сохранения компонента в текущей библиотеке компонент>сохранить или компонент>сохранить как. Однако перед выполнением этих команд все равно проверяем наличие ошибок, и пока ошибки не исправлены, компонент сохранить нельзя. Имя нового компонента указывают по дополнительному запросу.
Символы компонентов заносятся в библиотечные файлы *.LIB по команде библиотека> сохранить как графических редакторов. В диалоговом окне этой команды имеется опция создать компонент если ее отметить, то созданный символ (или корпус) будет занесен в библиотеку как неполнозенный компонент, не имеющий корпуса (символа) и текстовой информации; по умолчанию он независимо от типа компонента получит префикс позиционного обозначения U; однако его можно немедленно наносить на схему (ПП) по команде размещение >части. Если же опцию создать компонент не отмечать, то он будет доступен для размещения только после создания полноценного компонента с помощью Library Executive, при этом, однако имеется возможность задать правильный префикс позиционного обозначения (для резисторов R, для диодов VD и т.д.)
4. Задание на работу
Каждый студент получает от преподавателя индивидуальное задание на разработку многосекционного компонента в форме его принципиальной схемы.

5. Порядок выполнения работы

Студент выполняет принципиальную схему многосекционного гомогенного компонента в системе P-CAD, а затем осуществляет его соединение с корпусом (шаблоном) в менеджере библиотек. 
6. Содержание отчета
Отчет по лабораторной работе должен содержать изображение разработанного студентом компонента в соответствии с выданным ему заданием.   
7. Список использованных источников

1. Инжиниринг электроприводов и систем автоматизации : учеб. пособие для вузов / М.П.Белов [и др.];под ред.В.А. Новикова, Л.М.Чернигова .- М. : Академия, 2006 .- 368с. (30 экз)
2. Стешенко, В.Б. P-CAD. Технология проектирования печатных плат : учеб. пособие для вузов / В.Б.Стешенко .- СПб. : БХВ-Петербург, 2003 .- 720с. (5 экз)

3. Покровский, Ф.Н. Материалы и компоненты радиоэлектронных средств : учеб. пособие для вузов / Ф.Н.Покровский .- М. : Горячая линия-Телеком, 2005 .- 350с. (10 экз)

4. Электротехнический справочник. В 4 т., Электротехнические изделия и устройства : в 4 т. / под общ.ред.:В.Г.Герасимова и др. — 9-е изд.,стер. — М. : Изд-во МЭИ, 2003 .— 518с. (4 экз) 
5. Предко, M. Справочник по PIC-микроконтроллерам / М.Предко;пер.с англ. — М. : ДМК Пресс, 2004 .— 512с. (2 экз)
6. Хетагуров, Я.А. Проектирование автоматизированных систем обработки информации и управления (АСОУИ : учебник для вузов / Я.А.Хетагуров .- М. : Высш.шк., 2006 .- 223с. (2 экз)
Практическая работа №4
Работа в графическом редакторе проектирования печатных плат

1. Цель работы и задачи работы
Изучение системы проектирования печатных плат PCAD (редактор PCB) и приобретение навыков проектирования электронных блоков с использованием данной системы. 
Задачей работы является разработка печатной платы для разработанной в лабораторной работе № 2 принципиальной схемы. 

2. Описание редактора печатных плат PCB
Информация о принципиальной схеме проектируемого модуля вводится в редактор с помощью команды Utils > Load NetList. При изображении платы и размещении компонентов на плате используются следующие фиксированные слои:

TOP - верхний слой, где размещаются обычно корпуса компонентов;

BOTTOM - нижний слой;

BOARD - границы платы;

TOP SILK - шелкография (рисунки и тексты) на верхней стороне платы;

BOT SILK- шелкография (рисунки и тексты) на нижней стороне платы;

TOP MASK- маска пайки на верхней стороне платы;

BOT MASK- маска пайки на нижней стороне платы;

TOP PAST - участки пайки на верхней стороне платы;

BOT PAST - участки пайки на нижней стороне платы;

TOP ASSY - вспомогательные данные на верхней стороне платы;

BOT ASSY - вспомогательные данные на нижней стороне платы;

Могут быть созданы также слои пользователя с произвольными именами. Общее количество слоев не более 99. Каждый слой может иметь свой тип S - слой с проводниками,  P -слой с металлизацией только для линий питания и земли,  N - вспомогательный слой без проводников. Слои имеют также статусы E - доступен для редактирования и D - выключен. Переключение редактируемых слоев осуществляется с помощью командной строки внизу окна редактирования. 

После того как Вы начертили весь чертеж целиком Вам необходимо зайти в Утилиты → Генерировать список соединений. В раскрытом окне, нажатием кнопки [Netlist Filename], указываем путь, куда должен быть сохранен получившийся файл с разрешением *.net. Значение [Netlist Format]=[P-CAD ASCII] оставляем без изменений.
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Рис. 2.1 – Окно настройки генерации списка соединений.

После генерации списка соединений (если все прошло успешно) входим в P-CAD 2001 PCB. Это может быть выполнено путем выбора Утилиты → P-CAD  PCB.

3. Объект исследования. Работа в P-CAD 2001 PCB.

В среде P-CAD 2001 PCB устанавливаем ту же библиотеку LIB_09.lib (процедура аналогична, как и в P-CAD 2001 Schematic), устанавливаем параметры листа (для этого требуется зайти в Опции → Конфигурация, там требуется установить единицы измерения – мм и размер рабочей области в мм, соответствующий, например, формату А2 -594 на 420 ), проверяем шаг сетки. После этого загружаем список соединений, полученный в пункте. Для этого заходим в Утилиты → Загрузить список соединений.

В раскрытом окне, нажатием кнопки [Список файлов], указываем путь, откуда должен быть загружен файл с разрешением *.net. Формат списка оставляем без изменения (P-CAD ASCII).

[image: image41.png]R
renmra oo 2]




Рис. 3.1 – Окно настройки загрузки списка соединений.

Если все прошло успешно, то в рабочей зоне появятся контура корпусов электрических элементов и соединяющие их проводники.

Ошибки при загрузке файла PCB *.net могут возникать из-за:
а) В файле *.net есть компоненты, которых нет в библиотеке подключенной к P-CAD 2001 PCB.

б) Проводник имеет меньше чем два конца:
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Рис. 3.2 – Ошибка файла *.net, если проводник имеет меньше чем два конца.
в) Неожиданный конец файла (где-то в файле присутствуют русские буквы). Для исправления этой ошибки необходимо зайти в Файл → Информация дизайна → Поля. В закладке поля, в поле Value требуется удалить все русские обозначения.
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Рис. 3.3 – Рабочая зона среды P-CAD 2001 PCB после загрузки списка соединений.

Если все прошло успешно, то заходим в слой Board и рисуем в нем, при помощи клавиши [image: image44.png]


, границы готовой печатной платы.

Для того чтобы войти в слой Board необходимо на нижней панели инструментов выбрать закладку “Слои” и найти требуемый слой.
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Рис. 3.4 – Расположение  закладки смены слоев.

После  того как Вы нарисовали контур печатной платы, переходите опять в слой Top и расставляете все электрический компоненты, так как они должны быть на готовой плате, не забывая при этом, что все разъемы должны находиться по периметру платы.
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Рис. 3.5 – Контур требуемой платы, прочерченный в слое Board.
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Рис. 3.6 – Упорядоченное расположение электрических компонентов

на готовой плате.
Кроме электрических компонентов на плате должны быть крепежные отверстия. Для их создания нажимаем на значок [image: image48.png]


 (контактная площадка) и ставим точку. После этого заходим в свойства этой точки и нажимаем кнопку “стили”. Во всплывающем окне выбираем любой стиль кроме “Default” и нажимаем “Modify (Complex) ”. В новом всплывающем окне меняем значение поля “Форма” на “Mounting Hole”. В поле диаметр вводим значение 4 мм. Нажимаем Ok, Закрыть, Ok и ваше крепежное отверстие готово. 

Далее его можно копировать в необходимом количестве и размещать в требуемых местах.
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Рис. 3.7 – Свойства компонента  “контактная площадка”
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Рис. 3.8 – Поле “Modify (Complex)”
4. Задание на работу
В данной работе студент не получает дополнительного задания, а использует разработанную ранее принципиальную схему.
5. Порядок выполнения работы

Студент осуществляет перенос информации, содержащейся в файле принципиальной схемы в файл печатной платы и осуществляет размещение элементов на плате.
6. Содержание отчета
Отчет по лабораторной работе должен содержать изображение разработанной студентом платы с размещенными элементами в соответствии с выданным ему заданием.   
7. Список использованных источников

1. Инжиниринг электроприводов и систем автоматизации : учеб. пособие для вузов / М.П.Белов [и др.];под ред.В.А. Новикова, Л.М.Чернигова .- М. : Академия, 2006 .- 368с. (30 экз)
2. Стешенко, В.Б. P-CAD. Технология проектирования печатных плат : учеб. пособие для вузов / В.Б.Стешенко .- СПб. : БХВ-Петербург, 2003 .- 720с. (5 экз)

3. Покровский, Ф.Н. Материалы и компоненты радиоэлектронных средств : учеб. пособие для вузов / Ф.Н.Покровский .- М. : Горячая линия-Телеком, 2005 .- 350с. (10 экз)

4. Электротехнический справочник. В 4 т., Электротехнические изделия и устройства : в 4 т. / под общ.ред.:В.Г.Герасимова и др. — 9-е изд.,стер. — М. : Изд-во МЭИ, 2003 .— 518с. (4 экз) 
5. Предко, M. Справочник по PIC-микроконтроллерам / М.Предко;пер.с англ. — М. : ДМК Пресс, 2004 .— 512с. (2 экз)
6. Хетагуров, Я.А. Проектирование автоматизированных систем обработки информации и управления (АСОУИ : учебник для вузов / Я.А.Хетагуров .- М. : Высш.шк., 2006 .- 223с. (2 экз)
Практическая работа №5
Автоматизированная трассировка печатной платы
1. Цель и задачи работы

Изучение системы автоматической трассировки печатных плат в системе PCAD и приобретение навыков работы с этой системой.

Задачей работы является трассировка печатной платы для принципиальной схемы, разработанной в лабораторной работе №2.
2. Описание подсистем QUICK ROUTE и Shape Based Route
Трассировщик печатных плат запускается из меню редактора PCB. (Route > Autorouter). Перед запуском необходимо сформировать стратегию трассировки (конфигурацию автотрассировщика). Стратегия сохраняется в файле с расширением STR, где указывается ширина проводников, стиль переходных отверстий, максимально допустимое количество переходных отверстий, типы проходов трассировки (вертикальные или горизонтальные трассы) и др. После формирования стратегии осуществляется трассировка и плата с разведенными трассами появляется в окне редактора PCB.

3. Объект исследования. Трассировщик Shape Based Route 
Для выполнения трассировки необходимо выбрать  Путь → Автороутеры. В появившемся окне можно сразу нажать старт. В процессе трассировки будут созданы файлы с разрешением “имя файла PCB”+“.14”+“.PRF” и другие файлы. Например: файл “*.14.PRF” нужен для передачи трассировки шин Shape Route.
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Рис. 3.1 – Окно настройки передачи данных для автотрассировки.

После нажатия “Старт” начинает свою работу новая программа P-CAD 2001 Shape-Based-Router , которая предназначена для автотроссировки.
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Рис. 3.2 – Рабочее поле программы P-CAD 2001 Shape-Based-Router.
Нажатием кнопки [image: image54.png]


 запускаем разводку трасс, после чего нажимаем File → Save and return и опять попадаем в P-CAD 2001 PCB в котором уже загружены разведенные трассы.
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Рис. 3.3 – Рабочее поле программы P-CAD 2001 Shape-Based-Router после разводки проводников.
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Рис. 3.4 – Рабочее поле программы P-CAD PCB после передачи разводки проводников из P-CAD 2001 Shape-Based-Router. 

Полученный после трассировки файл будет иметь имя, состоящее из имени исходного файла *.pcb  с добавлением в начале буквы “R”. Из полученного файла могут быть сформированы 2 и 3-й листы курсового проекта путем открытия различных слоев.

4. Задание на работу
В данной работе студент не получает дополнительного задания, а использует разработанную ранее плату с размещенными компонентами.

5. Порядок выполнения работы

Студент осуществляет автоматическую трассировку печатной платы и выполняет ее чертеж в соответствии с существующими стандартами.

6. Содержание отчета
Отчет по лабораторной работе должен содержать изображение разработанной студентом трассированной платы с размещенными элементами в соответствии с выданным ему заданием.   
7. Список использованных источников

1. Инжиниринг электроприводов и систем автоматизации : учеб. пособие для вузов / М.П.Белов [и др.];под ред.В.А. Новикова, Л.М.Чернигова .- М. : Академия, 2006 .- 368с. (30 экз)
2. Стешенко, В.Б. P-CAD. Технология проектирования печатных плат : учеб. пособие для вузов / В.Б.Стешенко .- СПб. : БХВ-Петербург, 2003 .- 720с. (5 экз)

3. Покровский, Ф.Н. Материалы и компоненты радиоэлектронных средств : учеб. пособие для вузов / Ф.Н.Покровский .- М. : Горячая линия-Телеком, 2005 .- 350с. (10 экз)
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